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This file documents the list of new features, enhancements, and “adjusted anomalies”, starting with the 
most recent version and finishing with the initial Rel 1.0 version.  Each page’s header shows the 
version for the current page. 

Changes for Do-more Designer 1.3 

1. DirectLOGIC Migration Utility 

To assist existing DirectLOGIC users who want to take advantage of Do-more, the new migration 
utility takes a DirectSOFT 05/06/205/350/405 project’s .TXT export file, and brings it into Do-more 
Designer as a Designer project. 

Although the Do-more architecture is different from DirectLOGIC (I/O is numbered in decimal not 
octal, no accumulator stack, separate code-block views instead of monolithic program, …), most of 
the contacts and basic coils migrate well, along with many boxes.  Any instructions that are now 
obsolete or are implemented differently, a $DL DirectLOGIC Stub instruction is used as a place-
holder within your Designer project to help you with the next step of migrating to Do-more. 

Of course, all Element Documentation (Nickname, Wiring Info, Description), and Ladder Comments 
come across.  If any element does not map directly to a Do-more element, it is mapped to an 
Unassigned Nickname so you can address it later.  All original DirectSOFT element text is 
appended to the Do-more element’s 6 line Description documentation field to assist with the 
migration process.  Access the utility via the File->Import->Migrate DirectSOFT Project menu. 

Below is an example using the tried and true DirectSOFT RLL_Example.prj project that has been 
shipping with DirectSOFT since the last millennium, next to its migrated Designer project. 

 

 

Note that the contact and coil logic came across, but that the I/O IDs changed from octal to their 
equivalent decimal ID so that they stay mapped to the same I/O point in Do-more.  The Output 
Window shows how DirectLOGIC’s constant tenths-of-a-second TMR preset was changed to 
milliseconds in Do-more.  The Migration Utility does not support 330/340 CPUs. 

This utility is a helpful step in taking advantage of the features in Do-more. 
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2. Instructions 

To utilize the new instructions and instruction changes, the CPU firmware requires at least Do-more 
Technology Version 1.3 (see Help->Do-more Technology Versions when online).  To upgrade your Do-more 
CPU firmware, select PLC->System Information menu (hit the Update button next to the Do-more/OS fields in 
the CPU Version Information group and follow the directions from there).  The firmware files that shipped with 
this version support Do-more Technology Version 1.3: h2dm1x_1_2_0.os for the 205 Do-more CPUs and 

t1hdm1x_1_1_0.os for the Terminator Do-more CPUs.  Note that newer firmware files may be available. 

a. New Instructions 

Added TMRAG - Global Accumulating Timer and UDCG - Global Up/Down Counter with no 
built-in reset mechanisms, so its Time or Counts can be measured independent of when a 
Program, Task, and/or Stage is terminated.  Also, neither has a Reset Input Leg, so their 
referenced Timer or Counter structures must be reset using the RSTT - Reset Timer or 
RSTCT - Reset Counter box. 

 

 

b. Instruction Changes 

i. To help customers who want to monitor or dynamically configure their SMTP EMail 
Server device configuration via ladder logic, the DEVREAD – Read Device Register and 
DEVWRITE - Write Device Register now support more SMTP Server STRING and numeric 
parameters. 

 

 

The new Register types for the SMTP Server device include the "From" EMail Address 
STRING, Authentication Mode, Authentication Account User Name STRING, and 
Authentication Account Password STRING. 

ii. Added new format type to STRPRINT – Print String and EMAIL – Send EMail Print Script’s 
FmtInt() Format Integer function: ipaddr, IP Address.  So STRPRINT "FmtInt(D42,ipaddr)" 
will generate "192.168.12.1" when D42 equals 0xC0A80C01. 



 Do-more Designer Updates Rel 1.3, April 3, 2014 

 Page 3 of 37 

3. OEM Utility: DMLoader.exe  

OEMs need to easily replicate a PLC system, whether it is during manufacturing or in the field as 
part of a field upgrade.  A utility that runs completely independent of Designer can download the 
“image” of a Do-more PLC into another Do-more PLC.  Hence, Do-more PLCs can be 
“programmed” without the need to know the details of Do-more Designer. 

The first half of this utility is the Image Generator, which runs within Do-more Designer.  Easily 
replicate an online PLC from within Designer via the File->Export->Generate DMLoader Image 
menu.  Various options include password protecting the image file itself, downloading the PLC 
firmware as part the image download, and customize the look of the DMLoader.exe utility with 
YOUR logo and YOUR detailed instructions. 

  
Once the DMLoader Image File .DLI is generated, anyone can install the DMLoader.exe utility 
from the Internet and upgrade their Do-more PLC if they have this .DLI file, without the need of 
understanding Do-more Designer or without the original .DMD Designer project file. 
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4. Enhancements 

a. The H2 and T1H Do-more firmware files that shipped with this release added support for 
Modbus Function Code 22 Mask Write Register on the Slave side only.  This operates on 
both Modbus/RTU (serial) and Modbus/TCP (Ethernet).  Update your firmware via the 
PLC->System Information menu (hit the Update button next to the Do-more/OS fields in the 
CPU Version Information group and follow the directions from there).  We are planning to add 
support for this function code on the master side in the future by enhancing the MWX 
instruction. 

b. Utilizes 1.3 .INI file, DmDesigner1_3.ini. 

c. Added new Ladder Option to fill an instruction’s Edit field with its Element text vs. its Nickname 
text when both fields are enabled and both exist (4395). 

d. Added new Ladder Option, While Editing a Rung to either 1. maintain an empty row at the 
bottom of the rung; or 2. do not automatically insert empty row at bottom of rung.  With option 1, 
as you draw wires, contacts, coils, or boxes, rows will automagically be inserted at the bottom, 
so you will not need to stop your ladder flow editing to manually insert an empty row “below the 
block cursor”. 

e. The PID Tuning History now logs the current PID Tuning Parameters before running 
Auto Tune for the first time (4432). 

f. Launch Pad’s individual Links items support a tooltip that provides the link’s Description, PLC 
Type, and Status (Failed, Good, Active, Paused, …) (4070). 

g. Documentation Editor’s Add Documentation Record dialog now supports adding a range of 
records.  This way you can easily add blocks of empty records to the Documentation Editor, 
similar to what you would see in DirectSOFT. 

  

h. Ladder View’s XRef Element tooltip also provides I/O module information for any I/O element 
like X, Y, WX, WY, including the slot, point #, or channel #. 
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i. Added support for STRINGs to the new Online Memory Data Import/Export Utility.  Import’s 
error reporting now provides the column number to help find/resolve any format/data issues. 

j. Updated the file format of the Export Element Documentation for the C-more, KepDirect, and 
Point of View software packages. 

k. DmLogger.exe utility now supports a file logging mechanism that you can initiate from a 
Do-more CPU.  Typically, you use STREAMOUT to the @DmLogger device, with the ASCII 
STRING you want to send to DmLogger.  If the STRING contains the prefix "#file:<filename>#", 
then DmLogger will append the remainder of that STRING to the specified file. 
 
For example, STREAMOUT @DmLogger "D10 = " D10 will simply log something like 
"D10 = 42" to the DmLogger window.  However, if the STREAMOUT looked like 
STREAMOUT @DmLogger "#file:c:\MyLog.txt#D10 = " D10, then not only would "D10 = 42" be 
written to the DmLogger window, but that text would also be appended to the end of the file 
c:\MyLog.txt. 

l. Trend View and PID View support a second logging format.  The original would log single 
values as individual elements’ values changed.  The new (default) format will log all values at a 
specified time interval, with all the values on a single line. 

  
The default is to Export/Log all element values at a specified time interval of 1.000 seconds 
(fastest interval is 100ms).  Below are two example log files, one where data is logged for all 
values once every 30 seconds, the second where the data is logged whenever a value changes. 

  

m. The Link Wizard Port page and the Configure Link’s Port page Device list support plug and 
play with USB to Serial converter cables which generate COMx PC serial ports dynamically. 

n. New Program Check Rules 

i. For simple Counter instructions, Warning W461 when they are used in an edge-triggered 
TASK since Counter Input Legs require a Full OFF-to-ON Transition (4400). 
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ii. Warning W424 when using a retentive bit in an OUT coil inside a non-retentive Stage 
(4703).  Hence, after a power cycle, the Stage will be inactive, but the OUT coil could still be 
ON. 

iii. Warning W403 when HALTing a PROGRAM or TASK that contains fully-asynchronous 
instructions (4414).  These instructions can be at any point in their execution when the 
containing code-block is HALTed. 

iv. For DEVREAD - Read Device Register and DEVWRITE - Write Device Register instructions, 
added Warning W708 when using an unsupported Register Type for the current PLC’s 
Do-More Technology Version.  At runtime, the DEVREAD will return a 0 for unsupported 
register types and DEVWRITE will be a NOP when writing to an unsupported register types 
(see 2.B.i above).  Just upgrade the Do-more firmware to the latest and greatest and this will 
go away (4600). 

v. Error E707 when using the new ipaddr format inside the FmtInt() STRPRINT or EMAIL Print 
Script when online with a Do-more PLC that does not have the proper Do-more Technology 
Version (see 2.B.ii above).  Just upgrade the Do-more firmware to the latest and greatest 
and this will go away, or format it the old fashioned way and cast the 4 tuples of the 
DWORD as Unsigned Bytes: D42:UB3 "." D42:UB2 "." D42:UB1 "." D42:UB0. 

5. Adjusted Anomalies 

a. Auto-complete properly includes the nicknames for all the valid elements for that specific 
element field (3448, 4573); shows up on first keystroke from outside Ladder Instruction editor 
(4572). 

b. During Paste of Ladder Logic, treat Documentation Import Errors as Warnings so that the logic 
still comes across, and log the “warnings” to the Output Window.  Properly handle pasting of 
code-blocks that include instructions that have @device parameters.  Properly handle 
nicknames of renamed PROGRAM/TASK code-block structure fields during Paste.  For 
example, when pasting SG $Main.S0 with nickname “RunMotor” to a new code-block MyProg, 
will become SG MyProg.S0 with MyProg.S0’s nickname altered to “_RunMotor1” to maintain the 
uniqueness of the “RunMotor” nickname tied to $Main.S0 (4403).  When pasting a new 
TASK/PROGRAM code-block, make its Initial Time Slice be 100 uSec and make user aware 
that they may want to tweak it.  Allow tall element documentation Description fields to be pasted 
(4539).  Improved performance of paste of large Ladder Clips. 

c. Sped up the display of large number of items to the Output Window. 

d. Restore Default Layout now adjusts the position of modeless dialogs (like Change Value and 
the Instruction Palette) in addition to dockable/floatable views like Data View (4527). 

e. Data View - no longer requires you to move off edit field to enable Write Current Value button 
(3350); better handling of multiple Data Views (4067); properly expands Date/Time structures 
(4502); properly displays status of high ASCII values in Quoted String format. 

f. Check for Updates now checking for Terminator CTRIO firmware. 

g. Export Element Documentation dialog now provides helpful information to choose the specific 
Output Format content. 

h. Parameter Range description for PUBLISH and SUBSCRIB working better (4497).  PUBLISH 
and SUBSCRIBE now consistently decoding the original DmT 1.0 Reverse Bytes flag (4736). 

i. Applying all Program Check Rules to logic inside all System Tasks. 

j. During Replace, report instruction validation errors (4494); properly perform replace on complex 
instructions from an online project uploaded from a PLC. 

k. Include element text in Instruction Validation error messages. 



 Do-more Designer Updates Rel 1.3, April 3, 2014 

 Page 7 of 37 

l. New Online Project supports launching the Do-more Simulator when attempting to open the 
MySim communication link. 

m. System Status dialog better handling of instruction addresses for instructions in error. 

n. Ladder Display now properly displaying MEMCOPY w/symbolic constant (4415); PEERLINK 
with status on (4612).  MRX/MWX ranges with a range of 1 (4648).  MRX/MWX properly reports 
end of range that is out of range (4649).  MRX and MWX properly reporting bit vs. register 
parameter sizing issues (4646).  ROTL/ROTR status shows Input/Output register in 
hexadecimal format.  Disallow REAL format from the ROTL/ROTR instruction (use :SD cast).  
When Accepting an edited rung with dangling contacts, coils and/or boxes, make the default be 
to keep them, not delete them.  Zoom level being maintained properly when Ladder View loses 
focus (4081).  Fixed INIT table field editing (4667, 4668, 4669).  Added Create Byte Buffer 
button to STRGETB and STRPUTB instruction editors (4666).  Properly maintain Rung 
Selection state across multiple views of the same code-block (4679).  GSREGRD and 
GSREGWR, removed reference to .StatusMonitor1 in description for parameter P6.31 (4672).  
When editing Stage instructions, the default Stage ID working better (4578).  Flag instructions 
as being modified only when any of the actual parameters change (4522).  MATH instruction 
editor no longer generates incorrect “math stack depth exceeded” error when entering 
expressions with functions that have at least 2 parameters like IF, MIN, STDEVR (4732). 

o. Find properly finds individual bit elements within a cast of a bit to a BYTE, WORD, DWORD, like 
finding C65 within the cast of C64:UW (4556); Find All better handles large number of results. 

p. I/O System View handles Local I/O Master Error Bits across all modules; better handling of 
reporting missing or inconsistent I/O modules. 

q. Added link to T1H-DM1 hardware manual in Launch Pad’s Applications group. 

r. Properly classify devices and structure fields of structures tied to Specialty I/O modules as 
Specialty I/O. 

s. XRef View, better display of expanded ranges. 

t. Reported Program Length on the Status Bar is much more accurate (2124). 

u. Simulator better handles missing Ethernet port or Ethernet cable on the PC. 

v. When manually configuring a Terminator I/O base in the System Configuration dialog, widened 
the hot spot and enhanced the hot spot graphic that shows up between the modules for the 
right-click context menu that is used to insert a new module. 

w. Fixed column sorting for the various Navigation List windows like Output Window, Find Results, 
and others. 

x. Various windows (like Project Browser) now properly receiving System Configuration 
notifications after a Paste or Insert Instructions From File when a new data-block, heap-item or 
device may be added to the project. 

y. STREAMOUT and STREAMIN editors’ Device selection drop-down box now supports Create 
Device (4174). 

z. Fixed broken web links to AutomationDirect.com’s product specification pages in System 
Configuration’s I/O Configuration page and in the I/O System View. 

aa. Fixed situation where Designer could lock-up during PC video configuration changes or other 
PC changes when online with status turned on. 
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Changes to Do-more Designer for 1.2 

1. Added support for the two newest Do-more CPUs, the T1H-DM1 and T1H-DM1E CPUs, which 
target the Terminator I/O platform.  Both CPUs contain a USB programming port and an RJ-12 
RS-232 serial port.  The T1H-DM1E model also has a built-in Ethernet port.  The serial port and 
optional Ethernet port are located on the bottom of the CPU module. 

Terminator is a well-established I/O platform, released in 2001.  This is the first PLC CPU for this 
I/O platform (all previous CPUs were for direct I/O control only, with no built-in ladder logic support). 

  

The local Terminator Base can support up to 16 I/O modules, including Terminator I/O’s high 
density analog modules.  At up to 16 channels per module, the local base can support up to 256 
Analog points (the T1H-DM1E can also support 16 slaves of Ethernet I/O for up to 4,000 I/O points). 

a. Creating a new Terminator Do-more project from Designer offline is just as simple as creating a 
new H2 205 Do-more CPU via the New Project dialog.  Creating a new online Communications 
Link via the Link Wizard automatically determines the Do-more CPU model. 

 

(note the new Do-more Hardware Class list) 
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2. Online Memory Data Import/Export Utility 

This is an online utility that can read data-block bit and numeric values from your Do-more PLC and 
dump them into a .CSV (comma separated variable) text file in readable form.  This file can then be 
easily imported by your favorite spreadsheet program, text editor, or back into Designer and written 
back down into your Do-more PLC.  You can also just use the Memory Data Import mechanism with 
a .CSV text file you created from scratch from your spreadsheet or text editor. 

Import is only available online, and is accessed from the File->Import->Memory Data menu.  
Export is also only available online, but is accessed from the File->Export->Memory Data menu. 

a. Export Memory Data (Do-more PLC to .CSV text file) 

First, generate a list of element ranges you wish to 
read up from the PLC and export.  Any built-in or 
user defined data-block of numeric or bit data can be 
exported.  Simply specify the Starting Element and 
Range.  The Ending Element is calculated.  Hit the 
Add to List button, then define and add the next 
range. 

Once all your element ranges are added to the list, 
decide how you wish to format the elements and 
values in your text export.  There are multiple 
options, so an Example Output box shows you how 
the data would look in your text file based on the 
options currently selected.  The example uses a 
dummy data set of 43 values from V100 thru V142 
that have the values of 0 thru 42, respectively. 

Next, hit the Export! button to bring up a Save-As 
dialog to choose the name of the .CSV file and folder 
the data will be exported to.  Once you hit the Save 
button in the Save-As dialog, the data will be read 
from the Do-more PLC and written to the .CSV file.  

After the data is read and written to the file, you are given the option to open the file to look at 
the data, or to open the folder where the file exists, or neither of these. 

b. Import Memory Data (text file to Do-more PLC) 

As long as the text in the file is formatted correctly, 
this tool will open the selected text file, read all of 
the element/values lists from the file, and show a 
confirmation dialog with the list of element ranges 
with the first few values of each range.  If there are 
any issues with the format, the errors will be 
dumped to the Output Window. 

Once you are ready to write the various list of 
values to their element ranges, just hit the 
Write to PLC button. 

 

The format of the Import file is based on the Export file format above.  Each list of element and 
data values must start with an element at the beginning of the line (e.g. V0 or C16), followed by 
any number of values on that line and successive lines which contain only values.  The end of 
the element range is implied by the number of values it finds.  Always start a new range on a 
new line beginning with the starting element of the new range.  For more examples of valid 
Import formats, look at the Example Output window mentioned in the Export dialog above. 
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3. Instruction Changes 

a. To help OEM and other customers who want to monitor or dynamically configure any serial 
port via ladder logic (built-in or SERIO/4 module), the DEVWRITE - Write Device Register and 
DEVREAD – Read Device Register now support multiple serial port parameters. 

 

 

The new Register types for serial ports include Baud Rate (must be one of 1200, 2400, 4800, 
9600, 19200, 38400, 57600, 115200), Data Bits (7 or 8), Stop Bits (1 or 2), Parity (0: None, 
1: Even, 2: Odd), Transmit/RTS Control (see Help topic DEVWRITE DMD0063 or DEVREAD 
DMD0062 for value encoding details), K-Sequence Slave Station ID, Modbus/RTU Slave Unit 
ID, Modbus/RTU Master Timeout, and Modbus/RTU Master Retries. 
 
This also requires an update to the H2 CPU OS firmware to at least 1.1.1 via the 
PLC->System Information menu (hit the Update button next to the Do-more/OS fields in the 
CPU Version Information group and follow the directions from there). 

4. Enhancements 

a. Project Browser’s Control Logic group, when sorted by execution order, will now show 
Unused System Tasks and any used Non-ordered Code-Blocks ($tFirstScan and 
$tLastScan, if used) below their own sub-tree. 
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b. Added Instruction scoping option to Cross Reference View, which shows the XRef listing for 
all the parameters of the instruction under the current Ladder view’s block cursor.  Other 
scoping options include the Ladder view’s current Point (parameter), current Rung, current 
Code-Block, and Full project: 

  

c. Utilizes 1.2 .INI file, DmDesigner1_2.ini. 

d. Added PLC Offline Setup dialog that lets you change the Project’s PLC Type when offline.  It is 
accessible from the PLC->Offline PLC Setup menu, or by clicking on the PLC designation 
pane in the Status Bar when offline. 

  

e. Added support for new System Status DWORD DST that reflects the PLC type as a numeric 
value in register DST29 (System Nickname $PLCType). 

0: Unknown 
1: Simulator 
2: H2-DM1 
3: H2-DM1E 
4: T1H-DM1 
5: T1H-DM1E 
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f. Added two new System Heap-Items 
STRING PartNum Part Number, like H2-DM1E 

STRING SerialNum Serial Number, like 00:E0:62:90:00:FD 

These require H2 firmware 1.1.1 or later (see item 3a on how to update). 

5. Adjusted Anomalies 

a. Replace Dialog:  Widened to accommodate longer code-block names (4546).  Added 
Remember These Selections checkbox to the Where to Replace group (4402).  Constants can 
no longer be Replaced; this is to prevent internal constant flag parameters from being 
manipulated; use Find and manually edit the constant parameter; With field can still be a 
constant (4513).  Replace and With element edit fields properly handle the auto-complete drop-
down list. 

b. I/O System View:  Maintains proper Z-order (4523).  Shows slave’s default I/O start address 
only when user sets it (4558). 

c. Terminator I/O configuration correctly showing proper bitmap for proper module. 

d. XRef Tool Tip properly includes element at end of a range for display and hot-key navigation 
(4514). 

e. System Configuration Dialog: Module Configuration entry dialog, renamed first column to 
Module Config Name.  I/O Configuration/Ethernet I/O Master entry dialog’s Rescan Slave’s I/O 
button is disabled when offline. 

f. Counter I/O Monitor utility:  Better handles CTRIO modules in Terminator.  Correctly displays 
Capture Register format as 32 bit integer or real. 

g. Ladder Editor/View:  IP Address sub-field and Constant Timer Preset sub-field editing 
improved.  Displays a better error message when "no devices available" is the selected Device 
parameter (4482).  Unsaved to Disk, Unsaved to PLC, and Uncompiled Change-Bars maintain 
state after compiling rungs with “dangling” instructions (4475).  MRX/MWX editing of the Enable 
options no longer report false error conditions (4568).  Status instruction layout now correct after 
doing a New Online Project in Run mode (4540).  Parameter editors that take only a string literal 
or string element (like STRFIND’s Find/Text field) properly handle F9 Element Browser selection 
of a string element (4601). 

h. Import Project properly sets Program Memory size to 65,536 instruction-words. 

i. XRef View:  No longer blank when opening a project (4524).  Expand-Ranges works better. 

j. Change Value dialog’s Element edit field now supports Auto Complete (4457). 

k. Program Check now prompts if you want to Accept any uncompiled rungs before continuing 
(4470). 
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Changes to Do-more Designer for 1.1 

1. Ethernet I/O - Added built-in support for over 4,000 discrete or analog I/O points.  The built-in 
Ethernet port of the H2-DM1E model CPUs have the option to enable an Ethernet I/O Master for up 
to 16 EBC100 bases (H2 and/or T1H) and/or GS-EDRV100 slaves.  In addition to discrete and 
analog I/O modules, the CTRIO/2 modules will also be supported natively in an EBC100 slave. 

a. Any existing Do-more CPUs with V1.0.x firmware will need to be upgraded to support Do-more 
Technology Version 1.1.  In Designer, select menu Help->Check for Updates to download the 
most recent firmware files.  Then select PLC->System Information when online to upgrade the 
firmware in your Do-more CPU.  Hit the Help button for details on how to upgrade the firmware 
in your CPU. 

b. Any existing EBC100 and GS-EDRV100 modules will need to have their firmware upgraded to 
support Do-more Ethernet I/O.  From NetEdit3, Run Live Update to download the latest 
firmware files off the Internet, then right-click on each module to Update Firmware.  Minimum 
firmware support needed by each module is documented in I/O Configuration Help Topic, 
DMD0249, under the Ethernet I/O Master section. 

c. Enable the Ethernet I/O Master using PLC->System Configuration menu, under the CPU 
Configuration entry, and look for the checkbox in the Ethernet I/O Master group. 
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d. Slave selection and configuration is also done in the System Configuration dialog, under the 
Ethernet I/O Master entry below the I/O Configuration node.  Adding slaves is easy when online 
using the built-in Query mechanism, or can be done manually when offline. 

  

e. When you hit the Add Multiple Slaves via Query… button, a dialog appears that lets you select 
the specific Ethernet slaves.  

  
Just check which ones you wish to Add, and then hit the Add Selected button. 
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f. Your I/O Configuration will now show the local base along with each slave. 

  

g. Each Ethernet Slave configuration allows you to adjust its Poll Rate, Timeout, and Retries.  You 
can also choose whether any Slave Error for that specific slave will kick the PLC out of RUN 
mode vs. remain in RUN mode on Slave Error.  If the PLC remains in RUN mode on slave error, 
you can also choose whether the slave must be online to enter RUN mode, either on power-up 
or on Program to Run transition.  Lastly, you can define that slave’s input values when an error 
occurs to either Be Cleared or to Hold Last State. 

  
Hit the Edit Slave… button on the Ethernet I/O Master entry of the System Configuration dialog 
to configure the currently selected slave. 
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h. The Discrete Inputs, Discrete Outputs, Analog Inputs, and Analog Outputs of your Ethernet I/O 
all show up in the image register memory as X, Y, WX, and WY, just like your local I/O. 

  

i. User can optionally set each expansion bases’ I/O addressing.  This might be used to help 
identify I/O base location by its address (e.g. expansion base starts at X200/Y200) or to allow 
padding for additional I/O modules in the “previous” base when I/O sequential numbering might 
cause addresses to “adjust” when these modules are added. 
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j. Added built-in native support for GS-EDRV100 devices, similar to the mechanism of how 
CTRIO is natively supported by Do-more.  When a user adds a GS-EDRV100 as an Ethernet 
I/O slave, a new GS-EDRV100 device gets created, along with a GS-EDRV100 heap item.  In 
lieu of using raw X/Y/WX/WY bits and registers, an intelligent device driver in the Do-more 
DM1E CPU provides a nicer interface through the heap item’s structure members, along with 
two additional instructions GSREGRD - GS EDrive Register Read and 
GSREGWR - GS EDrive Register Write.  See below for more details. 

k. To help with diagnosing I/O errors, see below for details on the new I/O System View and the 
new Ethernet I/O Monitor dialog. 

l. Offline/Manual Editing of Terminator Bases - Since Terminator systems do NOT have a 
mechanical base with pre-defined “slot” positions like a 205 base, the offline/manual editing to 
insert/add modules from within Do-more Designer must be supported a different way.  As you 
float your mouse cursor over the picture of your Terminator “base”, a blue hotspot block 
cursor is revealed whenever the mouse cursor is in the area between two modules.  This blue 
hotspot cursor lets the user know that they can right-click here to bring up the inter-module 
context menu (vs. the module-specific context menu when you right click the mouse cursor over 
the center of the module).  Just follow along the sub-menus with your mouse cursor to insert the 
specific module. 
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m. To help with monitoring Ethernet I/O System Status programatically, a new Heap Item structure 

was created ($EthIOMaster) that contains the following struct fields: 

Field Name Data Type Description 

.Warning Bit 
On if ANY Ethernet I/O base issues a warning; see 
.SlaveWarnings bit mask. 

.Error Bit 
On if ANY Ethernet I/O base issues an error; see 
.SlaveErrors bit mask. 

.SlaveWarnings 
Unsigned 
WORD 

Bit packed WORD of each slave’s Warning status (bit 
0 is for Slave 0, bit 1 is for Slave 1, … bit 15 is for 
Slave 15) 

.SlaveErrors 
Unsigned 
WORD 

Bit packed WORD of each slave’s Error status (bit 0 is 
for Slave 0, bit 1 is for Slave 1, … bit 15 is for Slave 
15) 

.Slave0RetryCnt 

thru 
.Slave15RetryCnt 

Unsigned 
BYTE 

Count of the number of retries for that specific Ethernet 
I/O slave (writable). 

.Slave0UpdateCnt 

thru 
.Slave15UpdateCnt 

Unsigned 
WORD 

Count of the number of successful communication 
updates for that specific Ethernet I/O slave (writable). 

.Slave0Error 

thru 
.Slave15Error 

Unsigned 
BYTE 

Error code of the last error state of that specific 
Ethernet I/O slave (writable).  See Help Topic Ethernet 
I/O Monitor, DMD0342. 

.Slave0ErrorInfo 

thru 
.Slave15ErrorInfo 

Unsigned 
BYTE 

Extended error information dependent upon the 
.Slave<n>Error code value of that specific Ethernet I/O 
slave (writable).  This is typically the module slot 
number (when applicable). 

Fields are read-only except where noted; the writable fields can be reset via logic or by 
communications, like Designer’s Data View or an HMI. 

For detailed assistance on using Ethernet I/O, such as configuring I/O starting addresses per slave, 
configuring the slave’s TCP/IP addresses, configuring Terminator analog, etc., look in the Do-more 
Designer Help System.  In the Help System, just search for "Ethernet I/O" (include quotation 
marks). 
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2. Instructions 

a. Instruction Changes  
Note: use of these new features require firmware for Do-more Technology Version 1.1 or later.  You will 
be notified at download time if CPU has older firmware that does not support the specific feature. 

i. STRPRINT, STRFIND, STRSUB, STRCMP, and DATAINFO instructions have an option for 
the Input Leg to be Power Flow Enabled instead of only being Edge Triggered.  Power 
Flow Enabled vs. Edge Triggered Input Leg can make processing easier in ladder logic. 

  

ii. MRX and MWX now accept a variable for the Unit ID, Modbus/TCP IP Address, Port 
Number, and Modbus Offset Address, allowing for indirect slave node and element 
address capabilities. 

iii. DLRX and DLWX now accept a variable for the Remote Address (Slave ID or IP Address), 
allowing for indirect slave node address capabilities. 

iv. MEMCLEAR now accepts a range of BITs. 

v. Expanded the PUBLISH and SUBSCRIBE byte swapping options.  Originally, the 
instructions only gave the option to “reverse bytes”.  This has been changed to allow one or 
both “swap bytes” or “swap words”.  This change actually ONLY affects DWORD sized 
elements, but allows for finer granularity when resolving byte-ordering issues. 

  

vi. NETTIME now accepts a variable for the SNTP Server IP Address, UDP Port Number, 
and Network Timeout parameters, allowing for runtime configurable IP Address 
parameters (see new DNSLOOKUP instruction below). 

vii. DEVREAD and DEVWRITE now allow you to read and modify a few SMTP Server (EMail) 
parameters at runtime. 

  

viii. The SCALE instruction now handles integer scaling that requires intermediate results larger 
than 32 bits.  Affected CPU firmware only, not Designer software. 
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b. New Instructions 

i. GSREGRD - GS EDrive Register Read and GSREGWR - GS EDrive Register Write 
instructions allow you to easily initialize the various configuration parameters, tweak runtime 
parameters, or monitor any/all drive parameters.  Both are table entry instructions similar to 
the INIT and PUBLISH/SUBSCRIBE instructions. 

     
 
To help navigate all of the various GS P#.## drive parameters, the Source/Destination row 
entry is performed in a secondary dialog form, which is accessed by selecting the Edit or 
Insert button in the instruction editor or double clicking on a specific row. 

This dialog form caters to both the expert 
and the new GS Drive user. 

The expert who may know the specific 
drive parameter address can simply enter 
“P” “2” <dot> “8” (Pulse Width Modulation 
Carrier Frequency), and the desired GS 
parameter address is filled out. 

The new user can navigate the tree in the 
bottom half of the dialog form, easily 
browse to determine which parameters are 
available, and just click on the desired 
parameter to select it.  There are two 
buttons at the bottom to help with 
navigation: Collapse All which shows the 
11 root “P” parameter groups, and Expand 
All which blows out all 11 groups (as seen 
here – note the scroll bar).  The root nodes 
individually collapse and expand just like 
navigating folders in your file system.  

The form and instruction validation is drive-aware, meaning that the list of possible 
parameters is dependent upon the associated drive type: GS1, GS2, or GS3.  For example, 
the set of PID Parameter Addresses (P7.##) will not be shown or be valid when dealing with 
a GS1 drive. 
 
Both the expert and the novice will appreciate the specification details provided at the top 
of the form: parameter description, parameter range, the number of implied decimal places, 
the default value, and for the Modbus gurus, the Modbus Holding Register address and its 
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corresponding Modbus Hexadecimal Address.  For those needing more detail, buttons are 
provided to browse to the ADC website and load the specific GSx drive’s manual or 
specification.  The Write Register instruction also lets the user know whether the parameter 
can be set in when the drive is in RUN mode.  The Write Register version also disallows 
setting any read-only parameters (e.g. P21.##). 
 
To help navigate all of the various GS P#.## drive parameters, the Source/Destination row 
entry is performed in a secondary dialog form, which is accessed by selecting the Edit or 
Insert button in the instruction editor or double clicking on a specific row. 

ii. PING – Ping Ethernet Device instruction lets you quickly verify the connection to an 
Ethernet device.  For IP Addressed addressing, it utilizes the standard ICMP Echo request, 
allowing it to work on any IP Addressed device, like a Modbus/TCP device, another Do-more 
PLC, an ECOM/ECOM100 module, network gateway, mail server, network printer, etc..  For 
Slave ID addressing, it utilizes the HEI Directed Broadcast request, allowing it to work with 
any Host Engineering Ethernet device, like ECOM/100, EBC/100, Do-more, etc., using 
NetEdit’s Module ID value when IP Addressing may not be defined.  The optional 
Round Trip Time parameter can be useful for establishing network timing/timeout values. 

  

iii. DNSLOOKUP – Name to IP Address instruction allows you to resolve a URL or computer 
name to its IP Address and stick it in a DWORD register, then utilize that DWORD register 
as a parameter in other Ethernet-based instructions that now accept a “variable” IP Address 
(like DEVWRITE to change SMTP Server Address, NETTIME, MRX/MWX, …). 
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3. I/O System View 

This new view details your I/O Configuration as a dockable/floatable view 
(like Data View) containing two panes.  The first pane is a Tree View that 
shows the hierarchy of your I/O sub-system.  The root of the hierarchical 
tree shows the I/O Masters: the Local I/O and any Ethernet I/O masters.  
The nodes below each root Master node contain all of the Slaves/Bases 
controlled by that specific Master.  The nodes below each Base node 
contain all of the Slot/Modules contained within that specific Base. 

The Second pane is an Information pane that shows more detail of the 
currently selected node in the first pane’s Tree View. 

When ran Offline, I/O System View provides a static hierarchical 
representation of your I/O configuration.  However when Online, it 
provides detailed runtime Warning and Error information, from 
Missing Module, to Bad Ethernet Communications, to Channel has 
Broken Transmitter, to Drive Tripped. 

Below is a 7 step trouble-shooting procedure, followed by the 
corresponding screen shot, which shows the intuitive steps to addressing 
most I/O Warning or Error. 

 

① - Designer Status Bar reveals some type of Warning or Error in the PLC.  Clicking on the 

Warning panel brings up the… 

② - System Information dialog box which lists all current PLC Errors and Warnings.  Seeing that 

the warning states that One or more I/O Masters are indicating a problem with a module - $IOError 
(ST152), the user just needs to click on the newly added button to Open the… 

③ - I/O System View, which hierarchically details the status of every Master, Slave/Base, 

Slot/Module.  In the example below, there is an issue below Master 1: Ethernet I/O Master, 1 base 
has a warning.  Below that Master, it shows that there is an issue below Base 2 (Terminator Base) 
(1 module warning).  Finally, below that Base, it shows that there is an issue in… 

④ - Slot 1 (T1F-16RTD/14THM) that has a Warning, denoted by the Yellow background color 

(errors are denoted in Red).  When the user clicks on any node in the tree, detailed information 
about that specific node shows up in the second pane of the I/O System view.  In this example, 
when the user clicks on the specific Slot that is in warning… 

⑤ - the bottom pane reveals that specifically, Channel 12 has failed on this module.  In addition 

to the live online status, there are… 

⑥ - hot links to both the Specification and the Manual for this (set of) part numbers.  Clicking on 

any of those links will… 

⑦ - launch the user’s web browser to the particular Specification or .PDF Manual on 

AutomationDirect.com’s website.  From there, the user can get additional information on the 
possible causes and resolutions of the warning or error. 
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4. Added Ethernet I/O Monitor utility to provide live Ethernet I/O communication quality statistics 
for each slave, along with general local Ethernet port statistics.  This is a modeless dialog, so a user 
is able to use other parts of Designer while it is open.  A “Copy to Clipboard” button at the bottom 
will format the data in CSV format and copy it into the Windows Clipboard.  This clip can then be 
pasted into a text file or email. 

  
It is available via the Debug->Ethernet I/O Monitor menu, and as a button on the System 
Information’s System Status tab below the Open I/O System View button, and as a button on the 
I/O System View toolbar. 
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5. Module configuration for the more-intelligent analog modules (specifically F2-8AD4DA-1, 
F2-8AD4DA-2, and the Terminator Analog Output/Combo modules).  The CPU will write the 
module’s configuration to the module’s Y/WY configuration bits/registers on Program->Run 
transition.  Note that these Y/WY settings can still be manipulated in RUN mode.  This 
“configuration” just allows the user to NOT have to create ladder logic in $tFirstScan to set the initial 
configuration.  The analog outputs will be Enabled by default on Terminator, hence making the 
Terminator analog modules work “out of the box” with Do-more. 
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6. Better support for tag-centric development by supporting Nickname sorting options in the 
element-centric Cross Reference and Documentation Editor views, including their Print outs. 

a. The Cross Reference View toolbar has a drop-down combo-box to sort the cross-reference 
table one of five ways: Sort by Element Ascending or Descending, Sort by Nickname 
Ascending or Descending, Sort by Data-Block #/ID. 

  

b. The Documentation Editor toolbar has a similar drop-down combo-box to sort the table. 
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7. Do-more Technology Version represents a specific level of functionality/set of features. 

a. Added Do-more Technology Version to both the disk-based and PLC-based project files.  
Added PLC Project’s Do-more Technology Version to System Information dialog (e.g. 1.0 vs. 
1.1). 

b. Created the Do-more Technology Version report dialog. 

Available via the Help->Do-more Technology Version 
menu, and as a button on the System Information 
dialog box.  Four different components can each have 
its own Technology Version: 
1. the current instance of the Do-more Designer PLC 
Programming software 
2. the current project on disk 
3. the current project in the PLC (when online) 
4. the PLC Operating System (when online) 

 

The Do-more Technology Version is NOT a software 
build version, but is THE “feature set” definition. 

Click on the Show Software Versions button to see 
the various software-firmware-Windows build 
versions. 

All of this version information can easily be copied to 
the Windows Clipboard as text by hitting the 
Copy to Clipboard button. 

 

c. The Project’s File->Properties dialog now also shows the Do-more Technology Version for the 
current project, which will also show up when you print the project’s Title Page. 

8. Enhancements 

a. Smart Pasting of Code-Blocks - Pasting an existing code-block within the same project now 
behaves like Windows File Manager when copying a file within the same folder.  It creates a 
new copy of the code-block named COPY_original-name and shows you how to rename it with 
a better name.  Cut/Copy/Paste of code-blocks are accessed from the Project Browser view by 
right clicking on a specific code-block under the Control Logic tree (note: you have to be in Edit 
mode Ctrl+E in order to cut or paste). 
 
Also, when pasting rungs that contain any “local” code-block variables (like Stage references), 
they will be replaced with the new code-block context.  So copying a rung from $Main that 
contains JMP $Main.S3 and pasting it into a different program code-block named RunBatch, 

will replace the JMP stage parameter: JMP RunBatch.S3. 

b. Added new Error Status bit ST153 - $EthMasterError.  This bit signals when the built-in 
Ethernet I/O Master device detects an error. 

c. Added new Status DWord DST49 - $EthMissedFrames which count how many Ethernet 
packets had to be ignored during a data storm due to limits on packet queue lengths. 

d. Easier Stage Flow Editing - User can now easily enter stage flow with sequential stage 
numbering without having to enter a stage number or hit F8 Accept Rungs after each rung.  For 
example, a sequence of 5 stages and 3 Jump instructions automagically default to the 
sequential Stage Bit simply by selecting the instruction (no parameter editing). 
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e. Cross Reference and Documentation Options’ dialog lets the user select the default sort 
order: Sort by Element Ascending/Descending, Sort by Nickname Ascending/Descending, or 
Sort by Data-Block #/ID.  The Print dialog boxes for these views have similar options. 

f. GS-EDRV100 Structure 

Each GS-EDRV100 will have its own heap-item as the primary 
mechanism for interfacing to the drive from the Do-more PLC. 

Key structure members include .OutputFrequency, 
.OutputCurrent, .Direction bit, and the internal and external 
communication fault bits, .IntCommFault, .ExtCommFault. 

 

g. Added Right-Click context menus to all 3 panes of the Launchpad (3528). 

  

h. Allow DM1E and Simulator Ethernet ports to listen for the Do-more protocol on a 2nd UDP 
Port Number.  The default port utilized by Do-more Designer and C-more is preconfigured 
0x7070 (28784).  Configure this 2nd port in the System Configuration’s CPU dialog. 
 
For the Do-more Designer’s Communication Link Configuration, the UDP Port Number for that 
specific link can be set via the Ethernet Advanced Settings dialog, accessible from the Port tab 
of the Configure Link dialog (default 28784). 
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i. Added What’s New link to the banner of the Start Page to bring up this document 
(Updates.pdf), along with highlighting the new Ethernet Expansion I/O feature in the 
Input/Output topic, and adding new content to the Data and Training topics. 

  

j. Added a Filter on Selected Range checkbox for the Nicknames list in the Element Browser 
dialog (F9 in any element field).  This way, you can see all the Nicknames for the currently 
selected data-block.  For example, list just the nicknames for the X (Discrete Input) data-block.  
The checkbox is enabled by default. 

 

vs. 

 

k. Cross-Reference View has option to expand simple ranges (on by default).  Sticky toolbar 
button Ex toggles this on and off.  Default state can be set in XRef View Options page. 
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l. Project Browser’s Control Logic context menu’s Debug Code-Block menu lets user RUN a 
Program, Edge-trigger Enable a Task, or HALT a Program or Task from within Designer.  

  

m. Added two new Ladder Options to the Options dialog: Default Zoom Level for New Views, and 
Ctrl+Mouse Wheel Zoom behavior. 

n. Added dynamic Cross-Reference navigation to Project Browser’s Control Logic tree’s context 
menu to go to the initiating RUN or ENTASK instruction of the selected code-block. 
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o. Output Window displays the selected entry’s “double-click” behavior in the title bar. 

  

p. New Program Check Rules 

i. Attempting to download enhanced Dm 1.1 version instruction features into an older Dm 1.0 
version CPU (see instruction enhancements) will generate an error.  User is warned when 
editing the instructions offline, and possibly again during Program Check when an error 
could occur at download time.  Example: selecting the new power-flow enabled STRPRINT 
into a CPU running the old V1.0 firmware that does not support that feature.  To fix this 
error, user would need to upgrade the CPU’s firmware or modify the specific STRPRINT 
instruction back to being enabled by edge-trigger. 

ii. Invalid CTRIO file types when utilized in the various CTRIO instructions will generate an 
error.  Example: inhibit a CTDYNVEL Dynamic Velocity instruction from using a 
Programmable Limit Switch (PLS) Table file. 

iii. “Disconnected” module configurations will generate a message (info).  A module 
configuration becomes disconnected when a complex module that has some type of 
configuration (e.g. CTRIO module) is deleted or becomes missing from the system.  Rather 
than also blindly deleting the configuration attached to the module, the configuration is 
maintained in “disconnected” module, just in case the user wants to later add back that 
module and “connect” the new module to this configuration. 
 
However, in a prototyping or test system, these “disconnected” module configurations can 
easily build-up over time.  This Program Check Message rule provides a reminder to the 
user that they still exist.  Double-clicking on this rule in the Output Window brings up the 
Module Configuration section of the System Configuration dialog.  The Module Configuration 
dialog contains the new Delete Disconnected button to delete ALL of the “disconnected” 
module configurations. 

iv. Added three general rules related to incompatible Do-more Technology features in the 
project being downloaded compared to the PLC being downloaded to.  1. Report an error 
when attempting to download a new instruction added at a specific Technology Version, but 
the CPU’s operating system’s  Technology version does not support it.  2. Report a warning 
when downloading a project with a new feature enabled that is not available in the CPU, 
where the PLC can still function, but the new feature will be ignored by the old firmware.  
3. Similar to #2, except report an error when the specific feature cannot be ignored and 
would confuse the older firmware. 
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9. New Installation Paths 

a. Windows Start Menu contains a root Do-more folder, with a Designer 1.1 subfolder that 
contains shortcuts to the Designer 1.1 executables, Help, Read Me, etc.  If you also have 
Rel 1.0 Designer installed, that will remain below a root Do-more Designer folder in the 
Start Menu. 

  

b. Installation Drive Folder Path defaults to a similar structure.  At the root is the C:\Do-more 
folder, with a Designer1_1 subfolder that contains the Bin, Help, and Projects subfolders.  
Hence, the default Projects folder for Designer Rel 1.1 is C:\Do-more\Designer1_1\Projects. 
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c. Uninstall of Rel 1.0 may be desired after you have performed an upgrade to Rel 1.1.  This is 
completely optional.  You may want to keep Rel 1.0 installed in case you have any existing 
systems that you do not want to upgrade.  However, both Do-more Designer and CPU firmware 
upgrades are free, so you can get all the benefits of Rel 1.1 in any existing systems.  Note that 
Designer Rel 1.1 supports older .dmd project files and older Rel 1.0.x firmware CPUs, but the 
original Designer Rel 1.0 does not support newer .dmd project files and newer CPUs with 
Rel 1.1 firmware. 
 
To uninstall Rel 1.0, there is a shortcut to Uninstall Do-more Designer under its 
Do-more Designer Windows Start menu, or under Windows Control Panel’s Programs group.  
When uninstalling Rel 1.0, make sure you select “Do-more Designer”, not 
“Do-more Designer 1.1”. 

10. Designer Adjusted Anomalies 

a. Corrected some instructions’ Parameter Input/Output Type specifications. 

b. Pasting ladder rungs across projects is more permissive when dealing with elements that are in-range from the clip 
source project but out-of-range in the clip destination project. 

c. Corrected CTAXTRAP Instruction Browser Help content (4222). 

d. Display Unassigned Nicknames & Symbolic Constants in Element field (4221). 

e. MRX/MWX Do-more Range parameter now being displayed properly (4245). 

f. Make Replace dialog’s “specific code-block” field default to the current Ladder view (4219). 

g. Replace range of elements with documentation works properly. 

h. Stage instruction editors like JMP and SG now partially support the Create Nickname dialog by setting the “…assign 
to specified element” field to the first unused Stage bit (4158). 

i. “Resolving online and offline differences” properly handles hidden Edge Bit and Instruction ID parameters that cause 
the differences (2358, 3358).  Also added this as an option in the Compare Programs dialog box. 

j. Changes to the Execution Order dialog box: added $tTopOfScan and $tBottomOfScan code-blocks (4291); nickname 
for any code-block is shown in parentheses; the dialog box is resizable. 

k. Print-All’s Ladder code-block print-order now matches Execution-Order (4175). 

l. Contact Browser (F4) keyboard focus is set to list of contact tokens (4332). 

m. Replace <TAB> character in imported Ladder Comment with <SPACE> since <TAB> is not supported in the 
Comment Editor (3861). 

n. Ladder Clipboard Pasting or Import of Rung Comments no longer trims off the first line if it is blank (4082). 

o. Trend View draws static data better. 

p. Data View Export no longer truncates Real values at 4 decimal places (1829). 

q. Data View Increment ID functions properly with all element types (4218) 

r. Data View’s clipboard and archive file (Do-more Designer Data View Document *.ddt) properly handle differing 
memory configurations across multiple projects/PLCs (4317). 

s. Data View Element column editor now allows you to enter element text wider than the column (3286). 

t. System Configuration tables’ sorting is now case-insensitive (4220) 

u. Better handling of online status after a change to the Memory Configuration. 

v. Added hint to the title of the Output window when any of the entries perform an action if you double click on them, 
such as “go to the corresponding address in the code block” (3588). 

w. Edit History Details dialog now shows the current set of Pending Changes that will be in the next Revert point. 

x. Rearranged Launchpad’s Application’s group entries and added web link to the Do-more hardware .PDF manual. 

y. Export Project dialog’s option to export Built-In Memory Ranges will initially be checked if the any of the built-in 
memory ranges are different than the default memory configuration (4110). 

z. Clear the disk project’s associated communication link when user actively chooses the Disconnect from PLC menu 

command (4087). 

aa. Nickname edits are no longer lost after scrolling Documentation Editor (2254). 

bb. Numeric Edit fields now select entire field when control gains focus, for easier editing (4247). 

cc. Alert the user when attempting to download an “older” firmware version into the Do-more CPU.  Also alert when the 
firmware’s Do-More Technology Version happens to be older than the PLC’s Project’s Technology Version (4154). 

dd. Properly set focus to the correct MDI child after the Assign Nicknames dialog is dismissed (4172). 
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ee. Data View STRING editing handles ASCII character entry better (2200). 

ff. Output Window title bar displays the optional double-click behavior for the currently selected item in the list (e.g. 
Double-click to go to the corresponding address in the code block). 

gg. Properly handle communication status of large 1K STRING elements. 

hh. Find dialog’s keyboard focus now always defaults to the Element/Mnemonic/Instruction edit field whenever the Find 
tool is brought up (Ctrl+F). 

ii. Auto-complete edit fields now behave consistently when user hits the ENTER key when the mouse cursor happens to 
lie within the auto-complete drop down list vs. outside the list (4074). 

jj. DmLogger utility better handles file write errors when exporting log entries. 

kk. No longer lose Modified Rungs during Assign Nickname changes or any other Replace operation (3913), along with 
stable handling when Assigning Nicknames during edit of an instruction (4373). 

ll. Replace operation now iterates through all Accepted instructions, then also all Modified instructions within any 
Modified rungs (3913, 4373). 

mm. Smarter when closing a specific code-block’s Ladder View with modified rungs and let you either 1. Accept All rungs 
in All Code-Blocks, 2. Discard modified rungs in just the one view you are closing, or 3. Go out of Edit Mode and 
discard All Code-Blocks’ modified rungs (4358). 

nn. Properly activate and set focus to the new code-block view when the new code-block was created via ENTASK or 
RUN instruction in another code-block view (4344). 

oo. Properly export Data View data values when view is floating (4386). 

pp. Properly flag Documentation Database project file component as being changed on a System Configuration change. 

qq. Data View behaves better when attempting to add new entries via Ctrl+Enter beyond the bottom of the view (4408). 

rr. MEMCOPY properly displays ranges, and for Cross Reference (4316, 4325, 4416). 

ss. During Replace operation, properly copy/move documentation for casts of base “replace” elements. 

tt. Allow System Nicknames to be imported/pasted. 

uu. In the middle of downloading a project to a PLC, if an error occurred (e.g. communications lost), recommend users 
CLEAR their PLC since their PLC could now contain parts of two different projects, like the new System Configuration 
but the old Program based off the old System Configuration. 

vv. When cutting or copying a code-block into the Window’s clipboard from the Project Browser, if the code-block has 
any modified rungs, then prompt the user to Accept Rungs before performing the operation (4411). 

ww. Give the PLC time to mount devices when downloading a new project to the PLC. 

xx. Properly disallow periods in project file names (4410). 

yy. Failed, partial project download encourages user to perform Clear PLC (4097). 

zz. Copy/Cut of rungs, or Close of specific code-block’s Ladder View prompt user on what to do with modified/un-
accepted rungs (4411). 

aaa. System Information dialog, Events Log tab, log maintains sort order after Refresh List button is hit (4433). 

bbb. Program Check Warning Rule W201 Program XYZZY in RUN does not exist, now also flags missing code-block in 

TCPLISTEN instruction, not just RUN (4131). 

ccc. Project Browser/Control Logic tree better responds to element-documentation changes (4292). 

ddd. System Configuration dialog, Configuration Entries tree, I/O Configuration sub-tree are all initially expanded out. 

eee. Refined flagging “critical” System Configuration changes when online, but before downloading, when Designer and 
PLC’s Memory Configurations are “incompatible”. 

fff. Better handling of Wait Cursor (spinning cursor) during “blocked” lengthy communication operations. 

ggg. System Configuration, Module Configuration, added Master/Base in addition to the Slot number in Location column. 

hhh. Better handling of online status views after PLC->Disconnect, along with better handling of inconsistent System 
Configurations between Designer and PLC (4443). 

iii. Print Cross-Reference works better (4119). 

jjj. Do not allow duplicate Device names (4309). 

kkk. Simulator Example Projects take advantage of new power-flow enabled STRPRINT feature (4263). 

lll. Do not allow System Nicknames to be changed (4422). 

mmm. Do not allow Heap-Item names to match existing element names (4448). 

nnn. Element Browser nickname validation now matches Documentation Editor nickname validation (4375). 

ooo. Trend View and PID View data-snapshot now occurs on Left-Mouse-Up event, not on Down event. 

ppp. Better handling of a range of array-indexed parameter in Cross Reference view. 

qqq. Project Browser’s Memory tree hierarchy better organizes tree nodes (3998). 
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rrr. Corrected window title in System Configuration’s New/Edit UDP Connection Device dialog box (4458). 

sss. Corrected DLRX/DLWX editor’s Variable Continuous Interval field’s “red/green valid bulb” painting. 

ttt. Fixed an MFC Encountered an improper argument error message in Ladder Display (4471). 

uuu. STRCLEAR now properly reports ranges. 

vvv. Adjusted XRef Ladder Cursor tracking behavior. 

www. Project Browser’s Control Logic sub-tree better maintains its expansion state as changes are made. 

xxx. Eliminated memory leak during Print. 

yyy. Fixed display of parameter ranges in various ranged instructions. 

zzz. Fixed status display of BCD parameters in TOBCD and BCDTO instructions. 

aaaa. Adjusted status display of RAMPSOAK instruction. 

bbbb. Adjusted XRef tooltip text when dealing with uncompiled elements. 

cccc. Better handling of Unassigned Nicknames of Devices. 

dddd. Comment Editor’s Forward 5 Comment >> button works properly (4441). 

eeee. Properly reverse generate STRPRINT/EMAIL print script’s Lookup() command (also addresses Program Compare 
issues). 

ffff. Addressed Program Compare issues. 

11. Do-more Firmware Adjusted Anomalies 

a. Better handling of Guest Protocol memory ranges with DL and Modbus slave/server protocols. 

b. K-Sequence serial protocol supports Slave IDs other than 1. 

c. ALRATE – Rate of Change Alarm better handles initial update. 

d. Better handling of “Termination Scan” between ENTASK instruction and corresponding TASK code-block. 

e. Consistent handling of edge-triggered instructions. 

f. Better handling of network and print buffers. 

g. Added <NUL> character removal to STRTRIM – Trim Whitespace (in addition to <CR>, <LF>, <TAB>, etc.). 

h. Made hard low limit of Down Timer accumulators 0; high limit of Up Timer accumulators to 2,147,483,647 (int max). 

i. MEMCOPY validation works better. 

j. Bumped up pre-allocated Documentation sector storage from 512K to 1M. 

k. Properly erase various flash sectors. 

l. Better handling of writing Real values to Integer registers in Gate Array. 

m. Better handling of Modbus/TCP responses. 
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Changes to Do-more Designer for 1.0.2 

1. Enhancements 

a. Display Forces Suspended on Status Bar and in Ladder View element status when Force 
Table exists in PROGRAM mode. 

  

b. Updated the PLC->System Information… Update Operating System dialog. 

  

c. Inter-project paste operation now prompts on how to handle documentation differences (3734). 
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d. Make user PROGRAMs and TASKs non-retentive by default.  Added checkbox in 
Code-Block Configuration dialog to modify Retentive setting for heap-item based structures. 

  

e. Added support for $PgmModeRestart (ST15) available in Do-more firmware version 1.0.6. 

2. Adjusted Anomalies 

a. Delete key works in Trend View Options dialog for deleting elements and panes (3581). 

b. TCPLISTEN instruction editor invokes the Create Program dialog when you enter a new heap name (4115). 

c. Launch Pad as the Default View works (4101). 

d. MRX instruction’s To Do-more Memory Address parameter description no longer being clipped (4102). 

e. A few dialogs/forms display properly when DPI setting not 100% (4042, 4046). 

f. Print Ladder of large instructions working better (4053). 

g. TCP Client Device description reworded in Create Device dialog (4116). 

h. System Configuration’s Device list Heap Item display working better. 

i. Data View’s F9-Element Browser supports element selection (2704). 

j. Changed default option in Ladder View to display element status in simple contacts/coils (4127). 

k. Display new Modbus Address Type description in display of MRX/MWX instructions in addition to the editor. 

l. FREQTMR/FREQCNT Output parameter element range working better. 

m. Provide better error messages with invalid Stage Bit with Stage only parameters (SG, JMP, etc.) (4051). 

n. RUN/ENTASK/TCPLISTEN auto-code-block generation no longer leaves other view’s instruction editor displayed 
(4132). 

o. Now displaying ladder status for clipped relational contacts and multiple input box instructions (4123). 

p. Element Documentation display optimization in Ladder View working better. 

q. Import Project error message corrected (4152). 

r. Added helpful notes to password dialog. 

s. Memory Configuration, Retentive Range editing corrected (4151). 

t. Communication Server now flushing Force Table state after a Clear System RAM (4139). 

u. Properly flushing newly-unreferenced documentation record from element-doc-database when Memory Configuration 
no longer contains associated PLC element. 
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This is the first release of Do-more, so there are no updates to report. 

The Start Page introduces the new Do-more PLC and Do-more Designer, the new programming 
software.  Just click on the various topics and sub-topics. 

The Readme file may contain additional information. 


